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Preparing Content for Digital References and Studies
By Francis Adams

Part IV

Preparation of text and images for use in digital philatelic 
references and studies (DPS) is a must. With carefully pre-

pared text and images as your building blocks, the assembly of 
your work will go a lot smoother and result in a much more 
presentable DPS.

This article discusses how our text and images can be prepared 
for use in a DPS by going through some step-by-step instructions. 
These instructions do not cover operating a computer or install-
ing software. The scope of this article must be limited to only the 
necessary steps to accomplish specific tasks.

Text should be double-checked for spelling or grammar mis-
takes and saved in the proper format — before being inserted into 
the study. To ensure the best quality for illustrations, they should 
be sized appropriately, enhanced for display and in the proper 
format. We’ll begin with steps to prepare text content and then 
review how to prepare images.

Text
Most text is put into digital format by typing it into a comput-
er using a word processing program, such as Microsoft Word. 
There are two additional ways to get your text into digital for-
mat: scanning typewritten or printed pages and subsequently 
using optical character recognition (OCR) software to convert 
the scan into text or by dictation using voice recognition soft-
ware. (See page 7 for a review of OCR program that works well 
with Microsoft Word.)

We’ll stick with Word for this exercise, as that is what many 
people will be using. Three major reasons for using word proces-
sors are their spelling, thesaurus, and grammar checking functions. 
Once you have your text entered into your word processor, use 
these tools to ensure your text is as correct as you can manage.

If your word processing program doesn’t know a specific word, 
look it up in a dictionary before pressing the add to dictionary but-
ton. Once you’ve added a misspelled word, it will continue to accept 
the misspelling until you edit the user dictionary of your program.

The thesaurus is also an effective tool. Ever get stuck for just the 
right word? Enter a word you might use and see what turns up — 
it’s often the word you had on the tip of your tongue but couldn’t 
remember. Grammar checking is another standard function that 

may prove valuable. Leaving grammar check active during your 
text input will point out things the computer believes may be 
wrong word usage. You can ignore it of course, but it often makes 
suggestions you should consider. Using some of the other word 
processing tools, such as grade level analysis and word count, are 
interesting, but in the short term, we’ll stick with the big three.

Each program uses formatting code embedded in the docu-
ment to make your text display the way you want it to. The infor-
mation you enter is not simply text, but rather text with invisible 
code attached. Word is notorious for including formatting when 
text is copied and pasted into a document in another applica-
tion, such as MS PowerPoint. The invisible code gets the credit or 
blame for the appearance of the application into which it is im-
ported. To prevent this, save the document in a text only format 
(.txt). This  strips the invisible formatting code and leaves only 
the words. Cutting and pasting sections of a .txt file allows it to be 
formatted by the other program, PowerPoint in this instance, and 
introduces no surprises to figure out and frustrate us.

Enter all your text, spell and grammar check it, and then save 
it as a text only file. Formatting the text will be a function of the 
PowerPoint template.

Continued on Page 15

Fig. 1.  Saving the file in Text Only format
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The Photographer 
As Historian

Most amateur shutterbugs don’t realize it. Professional pho-
tographers busy satisfying clients’ demands, have no time 

to ponder it. Newspaper and television cameramen may realize it, 
but often ignore it. The it is the fact that the photographer is a his-
torian, often recording what future generations will know about 
us. I have pondered this from time to time and then relegated it 
to the deep recesses of my mind as current projects clamor for 
attention. However, the thought came to mind again as I was pre-
paring this issue and noted Peter Martin’s request for old photos 
of the Writers Unit and discussion of a shared library database.

I recall a presentation in the mid 1980s by a railroad historian, 
who commented about one photograph: “The photographer who 
took this picture really documented it.” He pointed out that it was 
marked with the date, including a clock tower that established 
exactly the time of day the shot was taken.

Those collecting Civil War era cartes d’visite will attest that 
those with clear identifications are much more valuable and de-
sirable than those without.

The lesson is clear: When anyone takes a photograph, no mat-
ter how trivial, it ought to be properly filed and identified with 
the date, time, location, and names of people it shows. In the case 
of traditional photography this means attaching captions to the 
backs of prints or to the sleeves for glass plates and negatives. 
Captions should include information about the persons who cre-
ated them and when they created.

Otherwise one may end up with a pile of nearly useless images. 
At one photo show I attended, one enterprising vendor with a pile 
of unidentified prints from the 1890s was hawking his wares as: 

“Instant Relatives.”
Those who have migrated to digital photography may believe 

their task is easier as cameras and scanners record metadata about 
the subject matter. The information includes the date an image was 
taken, camera and exposure data — even the camera’s serial number 
in some instances. However, the essential information — subject 
matter, names, the occasion, etc. — needs to be added. Most photo 
editing programs allow this to be done by editing the information 
file. In the case of electronic files, the job is not done until the images 
are backed up — off premises — on CD or DVD. Simply storing im-
ages on a hard drive does not guarantee their survival.

I must confess that I am much better at “do as I say” rather than 
“do as I do.”  I still have boxes of images, negatives, and filled slide 
carousels awaiting documentation. However, my chore pales in 
comparison to the task confronting my father — culling and fully 
identifying images to be saved from an accumulation of a quarter 
of a million images to has taken since the 1920s.	 ✒
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StampShow 2008 Breakfast
The Writers Unit will feature 
its normal Sunday breakfast at 
StampShow 2008 in Hartford, 
Connecticut. Breakfast Chair 
Steven Rod promises a fun 
time at the August 17 event, so 
plan to attend. (See page 9)

Our guest speaker will be 
David E. Failor, Executive Di-
rector of Stamp Services for 
the U.S. Postal Service, who 
will reflect on promoting U.S. 
stamp collecting.

He was appointed Executive 
Director, Stamp Services in No-
vember 2002 .  As director he is 
responsible for all aspects of the 
stamp program including de-
sign, manufacturing and distribution of 35 billion stamps per year.

He also serves as a member of the Coordinating Committee 
for the Smithsonian Institution’s National Postal Museum.

Writers Unit History
WU #30 Historian Steven Rod and I are spearheading an effort 
to document the 40-year history of the unit. If you have photos, 
ephemera, articles or stories related to the history of the organiza-
tion, please contact one of us via the addresses in the masthead. 
Photos of founders and officers are particularly need.	 ✒

Peter Martin

President’s
Message

Peter Martin

My Message
Remembering 
Barth Healey

It is with great sadness that I report the death of Barth Healey, 
Writers Unit #30 Eastern Vice President. News of his death came 

as I was writing my column. Few knew of the seriousness of his 
prostate cancer and we were all surprised by the announcement.

Barth is best remembered as the New York Times stamp colum-
nist, a position he held from 1988 to 1993 when the paper killed the 
weekly feature. His columns were always informative for collector 
and noncollector alike and earned him two Lidman Prizes for writ-
ing in the nonphilatelic press. Recently, Barth was heading up the 
WU #30 outreach program. He was a strong advocate for writers. 
We will all miss him. (See obituary on page 8.)

WU #30 Bylaws
Thanks to new Bylaws Committee Chair Katrina Everhart, a par-
liamentarian, we have a newly revised draft set of WU #30 bylaws. 
The bylaws, which adhere to Roberts Rules of Order, will be re-
viewed at our annual meeting at StampShow.

David E. Failor

Colopex 2008 
Literature Awards

Fourteen literature awards were presented for the competition 
held at Colopex 2008 in Columbus, OH from February 1–3.

Handbooks and Catalogues 
Grand Award
The Liberty Series, Ken Lawrence, C. David Eeles, and Anthony S. 

Wawrukiewicz, authors

Gold (Court of Honor)
The Congress Book 2007, American Philatelic Congress, Kenneth 

Trettin, editor

Gold
Canadian Postage Stamp Errors of The Queen Elizabeth II Era 

Volumes I, II, III, Joseph Monteiro, author
Index to Congress Books No. 1–No. 72 (1935–2006), John Kevin 

Doyle, editor
The Liberty Series, Ken Lawrence, C. David Eeles, and Anthony S. 

Wawrukiewicz, authors

Vermeil
Postal Censoring in Finland 1914–1918 CD-ROM (PDF), Roger 

Quinby, author

Silver
Levy’s Boy & Girl Scout Cachet Covers of the United States 

(catalogue), Jay L. Rogers, author

Society Journals, Periodicals, Newsletters 
Grand Award & Gold
The Finnish Philatelist Vol. 12, Nos. 1–4, Roger Quinby, author

Vermeil
The Journal of China Philately, Vol. 2, David Lu, publisher

Silver
Mexicans — The Journal of the Mexico-Elmhurst Philatelic 

Society International Vol. 56 (2007), Michael D. 
Roberts, editor

Henry Clay Stamp Notes, Vol. 20 (2007), John Cropper, editor
Knoxville Philatelic Society News of 2007 Nos. 1–12, Tom 

Broadhead, editor; Ralph Dinwiddie, publisher
Yule Log, Vol. 39 (2007), Tom Neufer Emswiler, editor; Janet 

Milne, editor 	 ✒
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Short Takes
News & Commentary

2008 Kehr Award Nominees Sought 
Nominees are beng sought for the annual Kehr Award that recog-
nizes a living philatelist who has contributed to the hobby’s future. 
The nominee should have demonstrated activities in one or more of 
these categories for at least five years: work showing a high level of 
creativity in making collecting attractive to newcomers; efforts show-
ing a high degree of dedication in working directly with newcomers 
and youth; and activity in developing and administering programs 
aimed at recruiting newcomers and fostering their growth.

Send the nominee’s name, accomplishments, and supporting 
documentation to the APS, Kehr Award Committee, 100 Match 
Factory Place, Bellefonte PA, 16823, by June 13. 

Rod Will Return in the Third Quarter
Steven J. Rod was unable to submit his Rod of History column for 
this issue because of other commitments. His contribution will 
return to the Communicator in the third quarter issue.

86th PHLNDX Update
The 86th update to the PHLNDX project was issued to the APRL 
at the beginning of March. This update encompasses approxi-
mately 5,500 entries. Areas covered are current publications, 
much of what was published in 1937–1938, and the first four vol-
umes of Stamps. A fairly extensive file of well beyond 100 titles of 

Letters
To the Editor

Preserving E-Data Still Moribund?

I thought the article on preserving electronic media in the recent 
issue of The Philatelic Communicator was interesting (David 

L. Straight, “Will Your Web Site Outlive You?,” first quarter 2008).
I recall attending a seminar at Pacific ’97 on the very same 

topic. I was not part of the discussion at Portland, but if I use the 
article as a guide it appears there has been little progress from a 
philatelic aspect to preserve electronic data such as Web sites.  We 
know some selected Web sites are saved at www.archive.org in 
the Wayback Machine, but I still see no effort by any philatelic 
library including the APRL to save anything.

As the article stated, the technology is there to capture them, but 
again using the article as an update there seems to be a lack of lead-
ership or any organized initiative to actually do something.

I would think the ideal leader would be someone with a library 
background to define a framework to gather, store, and index so 

people could use these materials as any other library materials. 
This problem cannot be unique to philately and I know of several 
Web sites that have disappeared over the years so some of that 
information is lost forever.

— Al Gore, by e-mail
Editor’s Note: Al Gore was formerly editor of The Compulat-
elist, quarterly publication of the now defunct Philatelic Comput-
ing Study Group.

The Amazing Wayback Machine

Regarding David Straight’s article on archiving data, I 
thought I would mention the Wayback Machine, the Inter-

net archiving site — www.archive.org. I was amazed a few 
years ago when I entered my old web page, which was at least 
10-years old, and there it was — not perfect, but generally most 
everything you might need for reference. Some graphics and 
links do not archive but it is a real “blast from the past.”

— Ronald Hill, Littleton, CO
Editor’s Note: Ronald Hill is editor of Scribblings, journal of 
the Rocky Mountain Philatelic Library.

We Welcome Your Letters
Let us know what you think. We always welcome your letters to 
the editor.	 ✒

pre-World War II titles for Belgium was captured — most titles in 
French or Dutch. Several more volumes of the London Philatelist 
get us through the beginning of World War I. Work is in progress 
on update 87.

— Gene Fricks

NASM Deputy Director Dies
Donald S. Lopez, 84, deputy director of the Smithsonian’s Na-
tional Air and Space Museum, died on March 3. Mr. Lopez had 
been with the Smithsonian Institution since 1972, when he be-
came part of the team led by Apollo 11 astronaut Michael Col-
lins responsible for planning the construction and opening of the 
museum. He was a legendary fighter and test pilot, having flown 
with the 23rd Fighter Group of the 14th Air Force, successors to 
Gen. Claire Chennault’s Flying Tigers.

Lopez authored Into the Teeth of the Tiger (Bantam, 1986), The 
National Air and Space Museum: A Visit in Pictures (Smithsonian 
Institution Press, 1989), and Fighter Pilot’s Heaven: Flight Testing 
the Early Jets (Smithsonian Institution Press, 1995).	

Expert Help for Writers and Editors
Charles J. Peterson, Writers Unit #30 past president, offers free 
critiques for periodicals and books / manuscripts. Submit the 
four most recent issues. Include postage equivalent to four times 
the first class mailing fee. Any unused amount will be returned. 
Critiques can be expected in about 30 days.

Inquire before sending books and manuscripts, providing 
a brief description. Return time will vary, depending on length 
and other commitments. Include a SASE. Send your materials 
to Peterson at P. O. Box 5559, Laurel, MD 20226. His phone is 
301-776-9822; e-mail cjp7777@aol.com.	 ✒
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A New Tool for Philatelic Writers and Researchers
By David L. Straight

During the first week of 
April, I joined Gini Horn, 

librarian for the American Phil-
atelic Research Library (APRL), 
along with representatives from 
the Rocky Mountain Philatelic 
Library in Denver, the Postal 
History Foundation in Tucson, 
and the Collectors Club of New 
York for a meeting in Bellefonte 
to explore how cooperation 
among philatelic libraries might 
lead to improved information 
access for library users.

These librarians agreed to 
establish an online union cata-
logue — a single shared bib-
liographic database that will 
reflect the collections of all the 
philatelic libraries that elect to 
join this project. The new co-
operative database will be built 
by adding records to the ex-
isting APRL online catalogue 
(www.stamplibrary.org). 
The first cooperative test data should be loaded by StampShow in 
August with a significant quantity of new records expected to be 
available to researchers by the end of the calendar year.

Since many philatelic libraries operate from drawers of cards 
and most do not have their catalogues posted to the Internet, the 
ability to check the holdings of several philatelic libraries with a 
single search from the comfort of your stamp room will be a signifi-
cant advancement for philatelic writers, researchers, and scholars. 
Heightened visibility for their holdings should increase the use of 
their collections for all the libraries involved in the new database.

Initially, participation in this project is open to any philatelic li-
brary in North America. After the database is functioning smooth-
ly, the inclusion of libraries from other parts of the world will be 
considered. A meeting to demonstrate the shared bibliographic da-

tabase and answer questions about this project will be held during 
StampShow in Hartford, CT at 1 p.m. on Friday, August 15.

This group of librarians has agreed to meet annually to re-
view progress on the database and explore other avenues for 
library cooperation. Their next meeting, open to all philatelic 
librarians, will be held at the Rocky Mountain Philatelic Li-
brary in May 2009.

Also, a Web site will be created where librarians can post docu-
ments, lists, and hold discussions related to the creation of the 
shared bibliographic database, their indexing projects, the ex-
change of duplicate materials (especially for filling gaps in peri-
odical holdings), and other relevant topics. Librarians wishing to 
participate in these web discussions should contact Gini Horn 
(gini@stamps.org) for a password.	 ✒

Librarians Meeting
David L. Straight, center back, discusses the new library project with, clockwise right, 
Gini Horn, APRL librarian; Mark Banchik, Collectors Club of New York; Paul A. Nelson, 
Postal History Foundation; and Roger Rydberg and Ellengail Beuthel, Rocky Mountain 
Philatelic Library.

B
ar

b
 B

oa
l /

 A
P

S
 p

ho
to

ATA Honoring Dennis Dengel 
Dennis Dengel of Poughkeepsie, NY, a member of Writers 

Unit #30, has been selected as the American Topical Asso-
ciation’s 2008 Distinguished Topical Philatelist. The award will be 
presented on June 14 at the awards banquet during the ATA’s an-
nual convention in Portland, OR.The award was established in 
1949 to recognize notable service to topical philately. 

Dengel is an ATA life member and has served since 1994 as 
secretary-treasurer of its Americana Study Unit. He has served 
on ATA show committees in computer support since 2000, and 

has presented lectures at the National Topical Stamp Show to help 
members better understand electronic communications. He cur-
rently serves as chairman of the ATA audio-visual committee over-
seeing the transfer of the old ATA slide shows onto DVDs. He now 
authors the “Now Showing” column in Topical Time to help read-
ers better understand the process of converting slides to DVDs.

The National Topical Stamp Show will be June 13–15 in Clack-
amas, OR. For more information, contact Ray Cartier at the ATA, 
P. O. Box 57, Arlington, TX 76004-0057; telephone 817-274-1181; 
e-mail americantopical@msn.com; or check the ATA Web site 
www.americantopicalassn.org.	 ✒	
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Peterson Receives Lichtenstein Memorial Award
Former Writers Unit #30 president Charles J. Peterson has received the Alfred F. Lichtenstein Memorial Award and 
is flanked by previous winners. From left,  Robert P. Odenweller, Louis Grunin, Peterson, and Thomas C. Mazza.

Collectors Club  Honors 
Charles J. Peterson

By Alan Warren

At the annual awards banquet of the Collectors Club of New 
York on May 7, Charles J. Peterson was recognized with the 

Alfred F. Lichtenstein Memorial award for distinguished contri-
butions to philately. In his acceptance remarks, Charlie observed 
that his interest in stamps was rekindled many years ago while on 
an assignment in Italy.

During his many years in Europe as a civilian employee of the 
Department of the Army, he was not allowed to moonlight. How-
ever, known only to him, his wife Lanni, and Harry Lindquist, an 

interesting column appeared regularly in Stamps magazine under 
a nom de plume.

Charlie felt that he acquired some of his responsibilities in the 
field of philatelic literature through serendipity. He was in the 
right place at the right time when asked to become involved with 
the philatelic literature commission of FIP. He served as com-
mission president for 17 years and continues to serve on the FIP 
board. He is a past president of the Writers Unit 30 and has distin-
guished himself as past editor of Philatelic Literature Review and 
The Chronicle of the U.S. Classic Postal Issues.

The Lichtenstein award is now added to Charlie’s long list of hon-
ors that include the Writers Unit Hall of Fame, Roll of Distinguished 
Philatelists, and the APS Luff award (twice). He credits Daniel Vooys 
and Bud Hennig with encouraging him as his mentors. In closing, 
Charlie wished the New York group’s success in planning the 2016 
international exhibition to be held in that city.	 ✒

Winter, Proud, Startup to Sign 
Distinguished Philatelists Roll 

Richard F. Winter of Greensboro, NC, a member of Writers 
Unit #30; Edward W. B. Proud of the United Kingdom; and 

Robin M. Startup of New Zealand have been invited to sign the 
Roll of Distinguished Philatelists at the Philatelic Congress of 
Great Britain at Stratford-upon-Avon on July 26.

A retired Navy commander, Winter edited the foreign mails 
section of the Chronicle of the U.S. Classic Postal Issues, the U.S. 
Philatelic Classics Society journal, for more than 20 years. He 
has written more than 80 articles on transatlantic mail. Winter 
coauthored North Atlantic Mail Sailings, 1840–75, published by 

the USPCS in 1988. He also wrote Understanding Transatlantic 
Mail, Volume 1, published by the APS in 2006, and he is working 
on Volume 2.

Proud authored a series of handbooks on British Colonial 
postal history, covering 81 colonies or protectorates. He also 
initiated the magazine Postal History International (1972–79). 
He has been honored by an award from Italy’s Associazione Ital-
iana di Storia Postale for his work in promoting philately and 
postal history.

Startup is the foremost postal historian in New Zealand. He is 
the author of or contributor to more than 60 books, including com-
plete sections of Volumes 3 and 4 of The Postage Stamps of New 
Zealand, and founder and editor of The Mail Coach, bimonthly 
journal of the Postal History Society of New Zealand.	 ✒
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Software for Digital Philatelic Studies
By Albert W. Starkweather

In his current article on digital references and studies, Francis 
Adams discusses two useful software tools — optical character 

recognition (OCR) and photo editing. There are two great pieces 
of software available for both Macintosh and Windows computers, 
one moderately priced and one free, that should satisfy these needs.

ReadIris Pro for OCR
Unless one is a master typist or has access to one, optical character 
recognition is the alternative to converting printed documents into 
editable text. Most scanners come with some bundled version of 
OCR software; most is inferior. When Xerox TextBridge Pro was 
no longer developed for Macintosh, I tested several programs and 
finally settled on ReadIris Pro 11 (www.irislink.com) because of 
its ease of use, reliability, and competitive pricing..

ReadIris works seamlessly with my scanner and Microsoft 
Word, handling most good source material automatically. Good 
means printed text that is printed in black on a white background 
in a traditional font, such as Times.  Gray or colored type and that 
on non-white backgrounds works less successfully, as does sans 
serif or extremely stylized fonts.

Setting up the software is extremely easy, mostly involving se-
lecting your scanner and target application from drop-down lists — 
an Epson Perfection scanner and MS Word in my case. Converting 
a document involves turning on the scanner, placing a document 
on its bed, and clicking acquire on the ReadIris screen. The docu-
ment is then scanned, recognized, and then copied and pasted into 
the word processing program. With good source material accuracy 
is nearly 100 percent. (The example shown above right was the 
source of the Colopex report on page 3.)

There is a more interactive approach to problematical material, 
which allows the user to define areas to be scanned, to train rec-
ognition of characters the program does not recognize, and to set 
other customized options. The automated process takes only sec-
onds, while the interactive method may take up to several min-
utes, depending on the number of characters that are not recog-
nized. Similar documents will be processed much more quickly 
once training information is saved.

No matter which approach is used, it is very important to 
proofread carefully once the text is imported.

Street price is about $110, a whopping $390 less than its lead-
ing competitor, OmniPage Pro 16. 

Olympus Master 2
Although Francis Adams is a proponent of Adobe Photoshop Ele-
ments and I rely solely on Adobe Photoshop CS3 Extended, there 
are alternatives. One of my favorites is Olympus Master 2, which 
is bundled with Olympus Digital Cameras and is available as a 
free download (www.olympusamerica.com). The program al-
lows anyone, regardless of the camera or scanner they own, to 
view, organize, edit, create, share, and print digital images.

Although I normally would turn up my nose at such a pro-
gram and had discarded earlier versions with previous Olympus 

cameras I have owned, I rediscovered Master 2 when a friend 
asked me to research Photoshop alternatives for a photo semi-
nar he was preparing.

Master 2’s editing palette offers resize, crop, insert text, bright-
ness & contrast, color balance, tone curve, gamma, auto tone cor-
rection, hue & saturation, monochrome & sepia, sharpness & blur, 
distortion correction, and red-eye reduction. All of these steps 
display the original image side-by-side with the unsaved output.  
This is particularly useful to less experienced users who get visual 
confirmation of they changes they are making.

The program is well documented and its animated help guide 
is particularly useful.

This is not a program for those who wish to create complex 
photo compositions or work on images needing a great deal of 
correction. However, for the quality of images being produced 
by today’s digital cameras and scanners Master 2 is perfect for 
producing print and on screen images.

Although Olympus also offers Olympus Studio 2, which offers 
more extensive image management, for $100,  Photoshop Ele-
ments 6 at well below $100 is a far better deal.	 ✒

ReadIris Pro 11, top, works seamlessly with your scan-
ner and word processing program. Olympus Master 2, 
below, is a convenient and free image editing program. 
Both are user friendly.
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Barth Healey, 1939–2008
Barth Healey, 68, an editor 

at the New York Times for 
three decades who also wrote 
the newspaper’s stamp column 
from 1988 to 1993, died March 
29 at a hospice in Melville, Long 
Island. The cause was complica-
tions from prostate cancer, said 
his son Matthew Healey, who is 
a designer and occasional writer 
for the newspaper.

Healey, who was Writers Unit 
#30 eastern vice president since 
1995, offered advice to Writers 
Unit member editors and au-
thors of philatelic journals in 
the areas of writing and layout. 
He was a national and FIP accredited philatelic literature judge.

He was an editor for more than 30 years at the New York Times, 
most recently on the foreign news desk. His stamp column gar-
nered him the Lidman Award for philatelic writing in the non-phil-
atelic press, in 1988 and again in 1993. He also served as editor of 
the American Philatelic Congress Book in 1995, 1996, and 1997.

Other journals in which his articles appeared include Linn’s 
Stamp News, the American Philatelist, and Scott Stamp Monthly. 
Healey’s collecting interests included diplomatic pouch mail, U.S. 
plate number coils and blocks, the Italian area, and topical collec-
tions on journalists and typography.

Drawing on his experience as a foreign correspondent and 
editor, Mr. Healey mixed straight-up news with social and po-

litical commentary to explore the world of philately in his col-
umn, Stamps, delving into the use of stamps as tools of political 
propaganda and public awareness. Among the topics he dis-
cussed were anti-Semitism in Nazi Germany, the Chinese ado-
ration of Mao and the reach of American pop culture overseas, 
as evidenced by the Rocky stamps released in several African 
and Caribbean countries.

John Bartholomew Healey was born in New York City on Sep-
tember 22, 1939. He graduated from Regis High School in Man-
hattan in 1956 and received a bachelor’s degree in mathematics 
from the College of the Holy Cross in Worcester, Mass., in 1960.

He began his journalism career in 1957, working as a clerk 
for the New York Times. It was there that he met his wife, Natalie 
(Lee) Healey, a secretary to Harrison E. Salisbury, then an assis-
tant managing editor. The Healeys were married in 1966 in East 
Pakistan, now Bangladesh, where Healey was working for the aid 
organization Catholic Relief Services.

Healey joined the Wall Street Journal upon returning to the 
United States and was the Rome bureau chief for the AP–Dow 
Jones News Service from 1969 to 1978. Among the stories he 
covered was the kidnapping of 11 oil ministers during an OPEC 
meeting in Vienna in December 1975.

In 1980, he rejoined the Times, where he was an editor on the 
business, news and foreign desks.

Mrs. Healey died in 2002. Mr. Healey is survived by two sons, 
Matthew Healey of Port Washington, NY and Adam Healey of 
Charlottesville, VA; two sisters, Beth Kossuth of Boston and Kate 
Sheehan of Niles, MI; one grandson; and his partner of four years, 
Jane Thomas.

— Fernanda Santos, New York Times, and Alan Warren  ✒

Barth Healey

James Negus, 1927–2008
James Negus died on February 22, his 81st birthday. He was a 

member of the Writers Unit Hall of Fame, having been elected 
to the honor in 1992. Perhaps he is best known for his landmark 
book Philatelic Literature: Compilation Techniques and Reference 
Sources, published in 1991. His career was based on book editing 
and technical information. In 1977 he was named editor of the 
Stanley Gibbons Catalogue, which position he held until 1981.

The London native previously was National Philatelic Society 
librarian from 1955–1961, during which time he compiled the lit-
erature index. He edited the society’s journal, The Stamp Lover, in 
1964 and 1965. He also edited the Journal of Chinese Philately and 
its forerunner from 1954–1960 and served the China Philatelic 
Society of London as research librarian from 1970–1976.

Negus was associate editor of the Philatelic Literature Review 
from 1969–1975 and consultant editor to Stamp World magazine 
in 1987. He was a prolific author and contributed articles and col-
umns to many of the major journals in the United Kingdom and 
the U.S. He was a fellow of the Royal Philatelic Society London.

— Alan Warren  ✒

Harvey M. Karlen, 1918–2008
Harvey M. Karlen, Ph.D., of Oak Park, IL died on February 9, 

11 days short of his 90th birthday. He authored 10 books and 
more than 100 published articles on Chicago postal history. He 
was inducted into Writers Unit #30 Hall of Fame in 2003.

Dr. Karlen was an historian, particularly in the field of postal 
history, as well as an internationally acclaimed philatelist and 
teacher. His first book, Chicago Postal History, was published in 
1970 by the Collectors Club of Chicago. His fourth book detailed 
postal history of the 1893 Colombian Exposition. His best known 
book is Chicago’s Crabgrass Community, which examines the re-
lationship between local postal services and neighborhoods that 
became part of the greater city.

Dr. Karlen earned an A.B. from the University of Chicago in 
1939 and his doctorate from the same university in 1950. A pro-
fessor of political science for 41 years in New York and at Chicago 
City College, he is recognized as a pioneer in teaching college 
courses on open circuit television.

Contributions in his name may be made to the Jewish United 
Fund of Chicago or Oak Park Temple B’Nai Abraham Zion.	 ✒
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APS StampShow 2008
August 14 to 17

Hartford Convention Center

Please join us for our 73rd
Writers Unit Breakfast
8:30 a.m. Sunday, Aug. 17

 More than 20 philatelic literature door prizes
The �rst 50 guests will receive a copy of J. W. Scott's 

“Metropolitan Philatelist,” his 1890s monthly publication

Tickets $22 until July 13 & $27 Thereafter
Call 814-933-3803 for Reservations

Speaker:  David Failor
USPS Executive Director of Stamp Services
Promoting U.S. Stamp Collecting

David Failor …
was appointed USPS Executive Director of 
Stamp Services in November 2002.

He is responsible for all aspects of the 
stamp program, including design, manu-
facturing, and distribution of 35 billion 
stamps per year.

He also serves as a member of the Coordinating Committee 
for the Smithsonian Institution’s National Postal Museum. 

Dale R. Pulver, 1929–2008
Dale R. Pulver, 76, of Mentor, 

OH, a prominent philatel-
ic researcher and authority on 
the stamps and postal history of 
Mexico, died March 26. He was 
a member of Writers Unit #30 
and wrote a monthly column 
on Mexican philately for Linn’s 
Stamp News for 25 years. His 
first column appeared on May 
9, 1983. His final column ap-
peared in the April 5 issue.

Pulver also wrote Introduc-
tion to the Stamps of Mexico, 
published in the Linn’s hand-
book series in 1992.

He was thrice honored by the 
U.S. Philatelic Classics Society, receiving the Stanley B. Ashbrook 
Cup in 1978 and the Lester G. Brookman Cup in 1986 and 2000.

Pulver won the Ashbrook Cup for his series of articles for the 
society’s The Chronicle of the U.S. Classic Postal Issues on the post-
al history of the Mexican-American War. The Brookman Cup is 
for outstanding service to the society.

His article on “The Analysis of Postal Markings on Pre-Stamp 
Covers of Mexico” in the 1987 Congress Book won the McCoy 
award for the best article in the annual publication.

Some of his many exhibits were shown internationally and 
won awards at Israphil 85 in Tel Aviv and  Ameripex 86.

Born June 18, 1929 in Rochester, NY he started his education 
in a one-room, stone schoolhouse in Spencerport, NY. He received 
a bachelor’s degree in chemical engineering from Cornell Univer-
sity. Pulver was a chemical engineer at the former Diamond Alkali 
Company in Painesville, OH for 34 years, prior to his retirement in 
1986. This included a five-year assignment in Mexico from 1964 to 
1969, which kindled his interest in the philately of Mexico.

Memorial contributions may be made to Advent Lutheran 
Church Memorial Fund, 7985 Munson Road, Mentor, OH 44060 
or to the American Philatelic Research Library for acquisition of 
Mexican philatelic research material, 100 Match Factory Place, 
Bellfont, PA 16823.

Dmytro Bykovetz, 1935–2008
Dmytro Bykovetz, Jr., 72, of suburban Philadelphia, died Febru-

ary 24. The retired postal worker was a longtime chairman of 
translation services for many philatelic organizations, including the 
APS, American First Day Cover Society, American Topical Associa-
tion, American Air Mail Society, and Vatican Philatelic Society.

The Ukraine native, who earned a B.A. in linguistics at Temple 
University, had recruited more than 100 volunteer translators af-
ter taking over the APS translation committee in 1977. 

He was awarded the John N. Luff award in 1990 for oustand-
ing servce to the APS. The ATA named him distinguished topical 
philatelist in 1989.

— Alan Warren  ✒

Dale R. Pulver
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Reviews
Print and Electronic

Women on Stamps Volume 5 may be the archetype of the new 
ATA handbooks and certainly is among the most useful. The 
handbook, which is cross referenced to the previous volumes, 
opens with a checklist of stamps featuring women, followed by 
short biographies which comprise the largest section, and con-
cludes with a new section that lists postal stationery and booklets 
depicting women. Biographies of women listed in previous vol-
umes are not included.

The cross referencing scheme is not perfect. For example, Dr. 
Mary Walker, the pioneering Civil War surgeon from Oswego, 
NY, is not listed, although the U.S. honored her in 1982.

Cockburn also has incorporated 13 gallery pages depicting 
stamps and stationery of women involved in stage and screen, lit-
erature, music, science and medicine, air and space, and sports. 
All but the last are in full color and on better quality paper. Al-
though the reason why particular subjects were selected is mysti-
fying, the galleries add a nice touch to the handbook.

Watercraft on Stamps II follows ATA’s new commitment to bet-
ter design and more attractive cover design, but falls short in the 
information it provides. Unlike Women on Stamps Volume 5 and 
despite the addition of four supplements on naval history, this 
handbook is little more than a glorified checklist.

The supplements, each four to six pages, cover “The Very First 
Boats — Dugouts,” “Viking Boats,” “Clipper Ships,” and “The Pana-
ma Canal.” Each is well illustrated with subject-related stamps. All 
are in full color, except for the Panama Canal section where only the 
first of its six pages is in color. Although they are in chronological 
order, these supplements fall far short of telling the history of wa-
tercraft. Missing are such important elements as the development 
of sailboats that expanded trade on the Nile River and in Mediter-
ranean countries and development of steam and nuclear power.

Although they are far from perfect. Watercraft on Stamps II and 
Women on Stamps Volume 5, show great improvment over the origi-
nal Watercraft on Stamps that is typical of the many handbooks ATA 
produced for years. Those books were mostly densely packed pages, 
occasionally broken with gray illustations, with unattractive type-
writer style fonts that only the most dedicated would tackle.

— Albert W. Starkweather

A Tale of Three ATA Handbooks
Women on Stamps Volume 5 by Helen Cockburn. 312 pages, 5½ × 
8½ inches, perfect bound. ©2007 American Topical Association. 
$22 for ATA members, $26 for nonmembers plus $3 U.S. post-
age, $9 for Canada and Mexico, and $11 elsewhere from ATA, 
P. O. Box 57, Arlington, TX 76004-0057.
Watercraft on Stamps II, Katherine A. Kirk, editor.  316 pages, 
5½ × 8½ inches, perfect bound. ©2007 ATA. Same prices.
Watercraft on Stamps, Katherine A. Kirk, editor. 170 pages, 
6 × 9 inches, perfect bound. ©1991 ATA.  $15 for ATA mem-
bers; $17 for nonmembers. Same shipping costs.

This  review could easily be subtitled “The Good, The Bad, and 
The Ugly.”  The good news is that the ATA appears to be mov-

ing in the right direction with its extensive selection of handbooks 
that are now produced in house, allowing it  much more control 
over the final product.

Books & Catalogues

Making the Congress Books More Useful
Index to Congress Books No. 1–No. 72 (1935–2006), compiled 
by David L. Herendeen and edited by John Kevin Doyle. 166 
pages, 7 × 10 inches, perfect bound. ©2007 American Philatelic 
Congress. $42 to U.S. addresses, $47 elsewhere postpaid from 
John Kevin Doyle, 5815 Lenox Road, Lisle IL 60532-3138.

The yearbooks of the American Philatelic Congress are a great 
resource for students of postal history. The diversity of topics 

and the depth of knowledge reflected in the articles require an 
index so that researchers can access the nuggets to be found in 
the pages of more than 70 years of publication.

Although several cumulative indices to these handbooks ap-
peared over the years, the present effort takes advantage of current 
technology not only to prepare an index, but also to maintain it 
online where it easily can be updated.The author index cites the 
article title, year, book number, and beginning page number. Many 
of these authors reflect the efforts of well-known contributors to 

philatelic literature such as Boker, Cohn, Brett, Graham, Herst, 
Klein, Lidman, Mueller, Rich, Stone, and Zirkle among others. 

The subject listings consume four times as many pages as the 
author listings. The subject entries carry author’s name and the 
same data as shown in the author listings.

An introduction to the volume would add some interesting 
detail such as a history of previous efforts to prepare indices of 
the Congress books, and a discussion of how the subject terms 
were selected, such as by the choice of the indexer or using a term 
guide like Smith and Kay’s Manual of Philatelic Headings Used by 
the American Philatelic Research Library. 

Names in the author listings and terms in the subject listings ap-
pear in bold print so that they stand out. The typeface is easy to read. 
Plans are to update the index annually on the American Philatelic 
Congress Web site (www.americanphilateliccongress.org) 
and to release a print version every five years if warranted.

— Alan Warren
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Catalogues, Handbooks & Yearbooks
The Postal Service Guide to U.S. Stamps 34th Edition. 368 pages, 
8¼ × 10½ inches, spiral bound. ©2007 for the USPS by Harp-
erCollins Publishers. $19.95 plus S&H from: USPS Stamp Ful-
fillment Services, P. O. Box 7247, Philadelphia, PA 19101 or 
800-STAMP-24.

The guide to U.S. stamps provides a basic list of U.S. regu-
lar issue and commemorative stamps from Scott 1 through 

4119, the 39-cent October 2006 Kwanzaa stamp. Also included 
are many back of the book items, including airmail, semipostals, 
official mail, newspaper stamps, duck stamps, stamped enve-
lopes, and postal cards. Souvenir pages and commemorative 
panels are also listed.

Listings are organized by Scott number, and the denomina-
tion, subject and date of issue are provided, along with values for 
used, unused, plate blocks/line pairs and first day covers. Major 
varieties are also provided. The vast majority of the stamps are 
illustrated in high-quality color. The 2007 program, while not 
catalogued, is described and illustrated at the front of the volume. 
With a publication date in the fall of 2007, one would expect that 
at least half the 2007 program should have been catalogued.

Interspersed throughout the catalogue are brief stories about 
selected stamp issues. A select reference list of organizations and 
publications is offered and is reasonably up to date, I find the orga-
nizational mix of listings somewhat strange as a number of smaller 
groups are listed, but the American Revenue Association is not.

One feature that you won’t often find is a complete list of the 
various series that the USPS has offered, along with the stamps that 
comprise the series. A brief glossary and an expansive topical index 
completes the work. The spiral binding is adequate for the 368-page 
book, which is 16 pages longer than the previous edition, and the 
price makes it a good deal for the beginning collector.
The 2007 Commemorative Stamp Yearbook. 64 pages with 117 
stamps, 8¾ × 11¼ inches, perfect bound. ©2007 for the USPS 
by HarperCollins Publishers. $64.95 plus S&H from: USPS 
Stamp Fulfillment Services, P. O. Box 7247, Philadelphia, PA 
19101 or 800-STAMP-24.

The latest edition of this USPS perennial best seller features a 
lighthouse during sunset on the cover and on the included, 

rather flimsy, cardboard slipcase. It is a slight step backward from 
the 2006 Commemorative Yearbook that came with a hard slipcase 
and with the stamps mounted on their appropriate pages.

As in past years, each commemorative stamp has a brief story 
accompanied by a variety of supporting illustrations and a place 
to mount the stamp or stamp set. Highlights included in the 2007 
volume are Oklahoma Statehood, Settlement of Jamestown, Star 
Wars, Pollination, Pacific Lighthouses, Marvel Super Heroes, Vin-
tage Speedboats, Alpine Tundra, Art of Disney, Polar Lights and 
individual stamps for Ella Fitzgerald, Henry Wadsworth Longfel-
low, Louis Comfort Tiffany, James Stewart, and Gerald Ford.

While the commemoratives are well covered, the regular is-
sues, airmails and special stamps are not. For example, stamps 
for Bighorn Sheep, the Forever stamp, Margaret Chase Smith, 
Harriet Beecher Stowe, Okefenokee Swamp and the Priority Mail 
and Express Mail issues are not included. The yearbook, with its 
attractive layout and high production quality, would make a nice 
gift but there is not enough substance for serious philatelists.

Collection Canada 2007. 100 pages with 52 stamps, 10¼ × 10¾ 
inches, perfect bound. ©2007 by Canada Post. $56.95 CAN 
from National Philatelic Centre, 75 St. Ninian St., Antigonish, 
NS B2G 2R8 Canada or 800-565-4362.

Collection Canada is the annual counterpart to the USPS’s 
Commemorative Stamp Yearbook. As in past years, Collection 

Canada 2007 outshines the quality production of its southern 
neighbor. The book has stories about each 2007 commemorative, 
but the features are more detailed, the layout and production are 
more impressive and the stamp mounts are already bound into 
the proper place. Even the nylon slipcase is more innovative. In 
this case it features a record with a guitar cover to highlight the 
Canadian Recording Artists set of four.

Stamps featured include: Flowers, insects, national parks, lilacs, 
endangered species, architects, law societies, scouts, flags, Inter-
national Polar Year, artist Mary Pratt, Montreal founding, Ottawa 
150th anniversary, George Vancouver, FIFA U-20 World Cup, Year 
of the Pig, and holidays. The illustrated stamps are thematically di-
vided into: The natural world; a respect for tradition; the perma-
nence of change; true Canadian legends; exploring the heart mind 
and soul; forging a national identity; and passions and pastimes. 

The write-ups are in English and French. The book includes an 
envelope with 52 mint stamps with a face value of $32.39. How-
ever, times have changed. In 2002 the price of the book was only 
about $8.50 more than the value of the stamps. Today its nearly 
$25 more. Still, this makes an excellent gift and it makes an atten-
tion-getting appearance on your coffee table.
2008 U.S. First Day Cover Catalogue and Checklist by Michael 
Mellone. 315 pages, 4¼ × 7 inches, perfect bound. ©2007 Scott 
Publishing, Sidney, OH. $12.99 plus S&H from Amos Hobby Pub-
lishing, 911 Vandemark Road, Sidney, OH 45365; 800-572-6885.

The 2008 annual edition of Mike Mellone’s first day cover cata-
logue lists FDCs through the June 2007 Pollination set. The 

format follows that of previous editions and identifies each Scott 
listed issue by Scott number and subject, followed by the first day 
date and city and, when known, the number of FDCs canceled. 
Values are provided for cacheted FDCs with singles, blocks, and 
plate blocks. A value for ceremony programs is also listed.

Stamp images are provided to help with stamp identification 
and an introductory section provides valuable information about 
leading cachet makers and how to service and collect FDCs. A ca-
chet calculator is included to allow collectors to get an approximate 
comparative value for each major cachet maker. Whether you are at 
home or at a show, this little book is an ideal reference that is useful 
for quickly checking Scott numbers and their first day dates.
Linn’s 2006 U.S. Stamp Yearbook by George Amick. 463 pages, 
6 × 9 inches, hardbound and softbound. ©2007 Linn’s Stamp 
News. $40 hard cover and $30 soft cover plus S&H from Amos 
Hobby Publishing, 911 Vandemark Road, Sidney, OH 45365. 
800-572-6885.

The 24th edition of the annual Linn’s Yearbook series has made 
its appearance and author George Amick has produced another 

gem. As in past years, he records each of the year’s issues, incorporates 
all the technical data and provides behind the scenes background 
information you will find nowhere else. Amick had his work cut 
out for him as 2006 saw a near-record 240 collectible varieties of 

Continued on Page 12
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Linn’s — Continued from Page 11
stamps and postal stationery, just missing the 2002 mark of 242. 

The near-record number of issues is largely due to the eight-
stamp Favorite Children’s Book Animals, 12-stamp Happy New Year, 
40-stamp Wonders of America, six-stamp Distinguished American 
Diplomats, 20 stamp D.C. Comic Book Super Heroes, 10-stamp 
Quilts of Gee’s Bend, and 10-stamp Southern Florida Wetland 
panes. For each 2006 issue, there are interviews with stamp design-
ers, comments from U.S. Postal Service officials, examples of pre-
liminary designs, coverage of first day ceremonies and much more. 

A few of the interesting background stories include how the 
40 Wonders of America categories and subjects were chosen 
and which ones were passed over; how a U.S. government offi-
cial who opposed giving asylum to refugees from Hitler’s perse-
cution almost wound up on a stamp and how the inept efforts of 
the Federal Duck Stamp Office in distributing its collector pane 
alienated collectors.

This beefy 463-page tome is packed with illustrations to sup-
port Amick’s easy to read narrative. All serious collectors of U.S. 
stamps should have this book on their shelves.

— Peter Martin

U.S. Classic Postal Issues Indexed
Annotated Cumulative Subject Index to The Chronicle of the U.S. 
Classic Postal Issues, Journal of the U.S. Philatelic Classics So-
ciety for Issue Numbers 1 through 200, compiled and published 
by Joseph J. Geraci, 2007, 591 pages with CD–ROM, 8½ × 11 
inches, card bound. Available from the author, P. O. Box 4129, 
Merrifield, VA 22116. Price $75 plus $10 shipping.

The allure of being able to find any item mentioned in the 
Chronicle since it first appeared in 1948 is beyond question. 

How well does this book accomplish that task? Readers often look 
at a reference book and open it at random. With this volume, that 
is a mistake. Each page is the same font size, some paragraphs are 
indented and occasionally a set of numbers is bold. There are no 
headers to let you know where you are in the book or to indicate 
a larger category.

With my first random choice, on page 352, I found a “, mute, 
cork, forged – 119:174*” that looked intriguing. But what cat-
egory did it refer to? Turning pages I found on page 350 the 
further sub-category “Philadelphia, Pa.” This was progress, but 
it was obviously not the full story. That required thumbing back 
to page 257 to find that it was part of “Towns [includes Special 
Service handstamps, Transatlantic markings, etc. For compre-
hensive listings by State or Territory, see United States, States.]” 
But this listing was part of a greater listing that started on page 
208 “Postal Markings, [see also Definitions for explanations of 
usage, by type; also individual markings by name].” Ultimately, 
it was necessary to turn back to page 115 to the listing “United 
States of America,” which was under a larger section “Countries 
and Subjects in Alphabetical Order/Subjects beginning with the 
letter “U,” on page 13.

Wise readers will consult the “Introduction and Key to the In-
dex” found on page 8. This section offers an explanation of the 
conventions used in the book and addresses the anomalies of spe-
cial issues of the Chronicle. It states on page 8 that “the Index is 
divided into seven Sections,” but the final one, Section 7, Author 
Index, has not been completed, and is not included. 

The entries are not annotated, and are given as only a volume 
and page number. Even if one had access to the full set of the 
Chronicle it is difficult to tell the circumstances under which an 
entry was made. The “forged mute cork” cancellation might have 
been discussed in detail or could just be a passing reference in an-
other article. The title of the article would have been a major plus 
for all the listings. Failing that, a list of the titles of all the articles 
could be presented in a linked database to permit that additional 

information to be a part of a search. Why not also include the 
name of the author?

A search under “Forgeries and Fakes” for something similar to 
the “forged mute cork cancellation” was frustrating. The alpha-
betized listing showed nothing under “mute” or “cork,” and, as 
with all the other lists, started with the issues by year. Scanning 
the volume/page numbers yielded an entry of the same number 
combination under “Postal Markings; Grids, 7 bar round[?} Grid, 
framed.” That helped a little, although it could have referred to a 
different marking. Returning to the previously skipped pages of 
listings by issue date, it was possible to find another under “1847, 
10¢ Added, tied by fake grid on stampless Philadelphia cover.” Fi-
nally, enough information had come to light to decide whether to 
look in the old Chronicle issues or not. This is not what one would 
call user-friendly.

Indexing is an art. The key is making it useful to the reader. 
In this case, running headers on each page to show its position 
within the larger outline, formatting (both bold print and differ-
ent type size) to show breaks in various groupings, and other de-
sign techniques would help.  

The CD-ROM that is included in the back of the book can be 
read with  Adobe Acrobat Reader 7, which is mentioned on page 
3 under the table of contents. Attempts to use it with earlier ver-
sions were unsuccessful. The directions for the CD on page 10 
omit this fact.

With Acrobat Reader 7, the search function works very well. 
I found that after the first two searches, those that followed were 
virtually instantaneous. The files shown in the Reader are the 
same as the book, but the main difference is in the ability to 
search for key words or volume/page combinations and across 
many categories, some of which may not seem obvious. To a 
large degree, this makes up for not knowing the right question 
to ask. In essence, the CD renders the book superfluous, but it 
is not sold separately.

This is a limited reference resource, of some use to those who 
may have access to the past issues of the Chronicle and time to 
work through the tedious process of finding the appropriate 
items based on key words. The CD improves this, but lack of the 
titles of articles and their authors is a flaw. Perhaps someone will 
complete the missing information and scan all the pages of the 
Chronicle, as was done recently with the London Philatelist. This 
would result in a very useful resource.

— Robert P. Odenweller



	 Second Quarter 2008	 13

Electronic Media

On the Trail of Czeslaw Slania

Many Web sites are devoted to the stamp engraving art. Some 
extremely interesting ones relate to the engravers themselves. 

Many of the best engravers and engraved stamps originate in Scan-
dinavian countries. Czeslaw Slania (1921–2005), one of the best 
known modern engravers, has numerous sites devoted to his mag-
nificent stamp art. He engraved his first stamp for Poland in 1951. 
By 1960 he was a full-time engraver for the Swedish Postal Service.

Several groups are devoted to studying Slania stamps. A nice 
description of the stamp engraving process can be found at 
www.norbyhus.dk/chuckm.html. It has information on Slania 
study groups, and links to other Slania sites. The page was created 
by the late Chuck Matlack and is now hosted by Toke Nørby at  
www.norbyhus.dk. Nørby’s site is also of interest and contains ex-
tensive information on Danish stamps, postal history, perfins, post-
marks, Danish ship mail, and links to numerous other postal sites.

Matlack said reasons to collect Slania’s work include: “Each piece 
is a work of art: An engraved stamp consists of thousands of tiny 
lines, dots and dashes that the human eye conceives as a cohesive 
picture.”; “Czeslaw Slania is the world’s most productive engraver.”

An amazing Slania exhibit was created by Ann Mette Heindorff 
at www.slaniastamps-heindorffhus.com. Visitors are invited 
to join an online discussion Slania message board. Beneath that 
are links to hundreds of Slania stamp pictures, arranged by coun-
try. Also pictured are Slania’s Banknote engravings, unused designs, 
revenue stamps, private engravings of movie stars, and more. One 
of the most interesting sections is on Joking Stamps, which shows 
the micro printing and small hidden engraved messages, and family 
names Slania frequently included in his art.

Others have continued the line art stamp engraving tradition, 
including Martin Morck whose site, www.martinmorck.com/
presentation-start-ram.htm, has an excellent illustrated sec-
tion on the engraving process. Illustrations of many of his stamps 
for Greenland, Denmark, Norway, Austria, and numerous other 

countries are also shown. He engraved the 32-cent Cal Farley and 
78-cent Alice Paul stamps in the U.S. great American series.

Piotr Naszarkowski, a 1980 graduate of the Warsaw Academy 
of Fine Arts, may be Slania’s heir apparent. He took over and com-
pleted final production of the joint 2006 U.S./Swedish Greta Garbo 
issue. He designed his first stamp in 1985 and has since moved to 
Sweden and designed more than 100 stamps for the Swedish post. 
His web gallery http://web.comhem.se/p.naszarkowski has an 
interesting section called recurring stamps, which shows stamps 
based on similar subjects. The Web gallery also contains portraits, 
bank notes, labels, drawings and a section filled with his unbeliev-
ably intricate black and white stamp designs as well as a separate 
section for the colored ones. Just look at the quality of the black and 
white 1993_abessiner.jpg cat in the black and white section and then 
compare it to the colored version. The black and white lighthouse 
design (2004_svenska_hogarna.jpg) is astonishingly complex. Plan 
to spend at least an hour at this site. If there isn’t a Piotr Naszarkows-
ki study group, there should and likely will be in future years.

— Heather Sweeting

StampExpo 400 Web  Site Established

A massive philatelic exhibition is being planned in conjunction 
with New York State’s celebration of the Hudson–Fulton–

Champlain Quadricentennial in 2009.
The 2009 Hudson-Fulton-Champlain Quadricentennial 

Stamp Exposition (StampExpo 400) is scheduled for September 
25–27, 2009 on the concourse of the Empire State Plaza in Albany, 
NY. This will be a signature event of the of the Quadricentennial 
celebration and is being sponsored by the New York Federation 
of Stamp Clubs, in conjunction with the New York State Hudson-
Fulton-Champlain Quadricentennial Commission. A Web site 
has been established for the show at www.stampexpo400.org.

The venue features more than two acres of space for dealers, a 
4,800 square foot exhibit room, and five meeting rooms. There is 
room for more than 300 frames of competitive exhibits.

StampExpo 400 chairman is Conrad Novick of South Glens 
Falls, New York, president of the Adirondack Stamp, Post Card 
& Ephemera Club. 

Information and questions about the event may be direct-
ed to Novick at stampexpo400@nystampclubs.org. Dealer 
questions and inquiries may be directed to John J. Nunes at 
nunesnook@aol.com.
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Journals & Newsletters

Astrophile Back on Track
Published bimonthly by the Space Topic Group (APS Space 
Unit), 5½ × 8½ inches, saddle stitched, 45 pages, color. Editor 
Jim Roth, P. O. Box 7606, Colorado Springs, CO 80933-7606; 
spaceuniteditor@comcast.net.

Editor Jim Roth has done a terrific job of getting Astrophile 
back on schedule after dealing with several health issues. 

The all-color journal  concentrates on space covers, with most 
articles dealing with rocket mail. The time period spans the 
entire space era.

A recent issue showed two flown covers from the 1936 experi-
mental  rocket plane flight from Greenwood Lake, New York by 
Willy Lee. In addition to two flown covers, the article is comple-
mented by collateral material including a letter  written by Willy 
Lee detailing the two flights and photographs from the actual 
flight. Another article in the same issue tells the story of Wernher 
von Braun and the development of the German V-2 rocket also 
illustrated with covers and photographs.

Besides space covers other articles looked at covers from 

the recovery ships that met 
astronauts upon splashdown. 
The articles show that these 
items are popular and have 
their own classification sys-
tem. Some are even contrived 
depending on the scarcity.

Articles ranged in length 
from one page to seven pages 
for feature articles and were 
clearly written with plenty of 
graphics and color illustra-
tions. News   regarding society 
activities and members begin 
each issue and a survey of 
recently issued space stamps 
concludes every journal.

— Alfred Carroccia

Briefly Noted
U.S.C.S. Log is published 
monthly by the Universal Ship 
Cancellation Society, Inc. The 
32-page, saddle stitched jour-
nal is 8 × 10½ inches.

The study of naval and mar-
itime postal is a unique postal 
history area because of its ever 
changing and evolving nature. 
Ships, particularly Navy, con-
tinually change ports, with 
many addresses and irregular 
ports of call on long tours. A 
result is many interesting cov-
ers with unusual cancellations 
and markings or cachets. The focus can center on ship name or 
class, cachets or postmarks. With pre-1930s covers the amount of 
material seems endless.

The November 2007 issue featured a Thanksgiving cover 
with a short narrative on the USS Tarpon where the cover was 
cancelled and its rubber stamped cachet. Eleven feature articles, 
most one page in length, present topics from all facets of naval 
history. The longest feature tells the story of the USS Serpens 
through the covers sent from one sailor and its tragic end in an 
explosion in 1945.

Other departments and regular columns keep the reader up 
to date on society news and activities. There is even a Norfolk 
Navy News column that updates individual ship news and as-
signments, a must if one collects individual ship cancellations. 
Rounding out the issue are two auctions, one with minimum 
bids under $10 and the second with minimum bids of $1 with 
many interesting ships.

This journal is well written and profusely illustrated. While the 
illustrations are black and white, the scans are clear and laid out in 
a format that complements the article. The issue was well balanced 
between articles and columns. Editor is Richard D. Jones. 747 Shard 
Court, Fremont, CA 94539; www.uscs.org.
Seal News is published quarterly by the Christmas Seal and 
Charity Stamp Society. It is 8 × 10½ inches, side stapled, approx-
imately 55 pages. Those who thought that collecting Christmas 
seals was boring and not within the pure definition of stamp 
collecting were wrong and should read carefully Seal News, par-
ticularly the Fall 2007 issue, which contains an excellent article 

“What Are Christmas Seals” by Florence Wright. This brief ar-
ticle was adapted from an exhibit and is an excellent primer for 
this area of philately.

Other articles examined seals on cover (a true cover has a 
seal tied by a cancellation), proofs, and Cinderellas. The arti-
cles are well written and researched and the illustrations clear 
although in black and white. An excellent feature of each issue 
is the interview with great seal collectors. The spotlight on one 
collector and his collecting interests is an asset to any club or 
society and can only encourage others in their individual pur-
suits. Society news and an auction are regular features to each 
issue. Editor is David Teisler, 268 Liden Ave., Red Hook, NY 
12571; teisler@aabt.org.

— Alfred Carroccia

Material for reviews may be sent to the editor. Reviews are also 
welcomed from others. Reviews should be concise and stress 
those aspects that are helpful examples (positive or negative) 
for other authors, editors, and publishers. Review requests from 
those having an interest in the item, such as publishers and dis-
tributors, must include a copy of the publication.	 ✒
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Preparing Content — Continued from Cover	

Images
As we’re not going to use prepared images or clip art, we’ll also 
need to get our illustrations into digital format. Methods to digi-
tize your images generally include scanning or using a digital 
camera. Scanning produces good images in general, but using a 
digital camera can also produce results that in some cases may be 
superior to scanning due to the quality of the camera’s optics and 
the ability to use its macro features. It depends on your equip-
ment and what your goal is as to how the images are captured.

Image manipulation is also part of this effort and a number 
of good image processing programs are available. My personal 
favorite is Adobe Photoshop Elements (version 6 as of this writ-
ing) as it has most of the features of full-blown Photoshop, but is 
priced at less than $100, a fraction of its big brother. (See page 7 
for a review of a free digital image editor, organizer, and browser 
that works with any digital camera or scanned image.)

The features in Elements continue to expand in number and 
are more than satisfactory for our needs. We’re not sending docu-
ments to commercial printers and that’s when Photoshop would 
be required to generate the commercial printer files.

Factors
The most important factors when preparing images for your study 
are: file format, resolution (clarity), size, focus, and color optimi-
zation. Making images appear on computer monitors correctly 
sized, with good color, and in focus prevents viewer frustration. 
This does not mean images should be “doctored” to no longer be a 
true representation of the original. Rather, they should be modi-
fied to display properly using the least amount of digital manipu-
lation while making the reproduction vibrant and clear. 

Let’s define image terms in plain English.
Format
Format of our image files is very important. Photographic 

images with colors/shades that blend into each other are best 
displayed in the Joint Photographic Experts Group (jpg) format. 
Tagged image file format (tiff) is good for photographic images as 
well, but the file sizes are very large and in most cases prohibitive. 
Illustrations using line art or large single color areas are best dis-
played in graphics interchange format (gif) format. This format 
presents the best option for small file sizes for this type of image.

Resolution
Resolution is a measurement of how many dots are contained 

within a single square inch commonly referred to as dots per inch 
(DPI). Editor’s Note: Computer programs, including Pho-
toshop, use pixels per inch (PPI), as the standard. DPI refers to 
printer resolution, while PPI refers to screen resolution. For our 
purposes, the terms may be used interchangeably.

Computer monitors typically display images at 72 or 96 DPI as 
a standard. If you magnify a standard DPI image on the computer 
screen, the image tends to become a bit fuzzy. That’s the result of 
the white space between the dots becoming more visible to the 
human eye. Make the image smaller and the dots squeeze closer 
together, making the image appear clearer.

If an image is prepared at 150 DPI, it will hold its clarity better 

than the standard DPI image when magnified slightly. The bot-
tom line is: higher DPI levels allow greater levels of magnification 
while maintaining clarity. This is also a factor in file size as higher 
DPI images are larger and require more disc storage space than 
lower DPI images.

We’ll work with tiff images to produce the best image possible 
before converting the image to a jpg or gif format to optimize the 
file size. That means it takes less disc storage space and appears 
quicker on the viewer’s computer monitor. The opposite side of the 
coin of course is image quality. There is always a trade-off when op-
timizing file size versus image quality. We’ll opt for a slightly larger 
file size but we’ll also get higher quality images that can be magni-
fied slightly and provide the viewer a closer look at image detail.

Size
Physical size of the image is simple. How many inches wide or 

high is the image? (This is not file size.)
Focus
Focus is perhaps the most important factor. If the image is not 

in focus to begin with, the viewer has difficulty determining what 
you’re trying to illustrate and automatically questions the image’s 
accuracy. Image focus is a function of the care taken when ob-
taining the original image. When using a camera to obtain im-
ages, ensure the item is in sharp focus.

Scanning images is less problematic in that the item being 
scanned is on a flat surface and the focus distance is predeter-
mined. However, ensure the item is placed flat against the glass of 
the scanning table or you may develop focus issues.

Color
Displaying color on a computer monitor has become less of 

an issue as modern monitors display millions of colors. The hu-
man eye cannot distinguish the millions of shades modern moni-
tors can display and reducing the number of colors in the image 
may help to reduce the overall file size of the image. Color may 
also vary depending on the age and/or calibration of the monitor, 
scanner or printer; a subject for another article.

Color Optimization
Correctly optimizing the color of an image will provide us 

with a more vibrant display on a computer screen. The optimiza-
tion we’ll be doing is setting the black and white points of the im-
age – adjusting what’s referred to as “levels”. Essentially, it’s how 
black is black and how white is white. It’s simpler than it sounds 
and helps to reduce image file size as well as making images more 
vibrant on computer displays.

Note: In performing the following image manipulation, we 
are not modifying the digital image such that it no longer repre-
sents the original philatelic item being depicted. (No pixels were 
harmed in the testing and production of these images!)

Caution: Before beginning to edit anything — text or images — 
ensure you’ve saved your files to a source folder on your hard drive. 
You may move a file from one folder to another. That does not nec-
essarily mean the file was copied into the new folder, it may have 
simply been moved. Copies of your original files should be the only 
ones worked on.

Back-up the entire folder with all your files to a different me-
dia storage device such as a compact disc (CD) or memory stick. 
Ensure you always have the original files in a safe place that is

Continued on Page 16
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Preparing Content — Continued from Page 15
 not easily accessible — prevent the accident before it happens; it’s 
only a matter of time otherwise.

Getting It Ready To Come Together
There are only a few basic steps involved in preparing images to 
make them ready for use in your DPS. If you do not follow the 
sequence as outlined below, image quality may suffer. (We’ll look 
at simple image manipulation within PowerPoint at a later date.)

I’ll note the menu commands and sequence using Photoshop 
Elements to perform these functions. Actions are in san-serif 
typeface and an arrow (▶) denotes a subsequent selection from 
the menu. These screen shots were made on a Macintosh, but 
should look very similar in Windows.

Source Location
Make a folder on your hard drive to hold all your images and text 

files. Ensure all your files are placed or saved into this folder. Note: 
You may also have sub-folders, which contain original images, text 
files, etc. depending on your organization methods. The important 
thing is that all the files are in the same area and easily found.

Capturing a Digital Image (Scanning)
	 1.	 Turn your scanner on and open your image software program.
	 2.	 Place the item in your scanner as squarely as possible and 

close the lid.
	 3.	 Selecting File ▶ Import ▶ Select Scanner Type.
	 4.	 Set the Resolution to 300 DPI.
	 5.	 Press the Preview button to view the image.
	 6.	 Select the area of the image to scan.

Note: Always select a scan area larger than the item being 
scanned. Doing this provides margins that are used when making 
further adjustments to the image through cropping, etc.

Fig. 2.  Scanning an image with Elements

	 7.	 Press the Scan button.
	 8.	 The scanned image appears in the window.
	 9.	 Press Save.
	10.	 Ensure the File Name and Location are correct.
	11.	 In the Format box, select tiff.
	12.	 Press Save.
	12.	 In tiff Options, select the following: Compression =  none’, Pixel 

Order = RGBRGB’, Byte Order = IBM PC.
	14.	 Press OK.

Fig. 3.  Selecting an image area to scan

Straightening an Image
	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.
	 2.	 Select the Straighten tool in the tool bar.
	 3.	 Draw a line parallel to a horizontal or vertical straight line in 

the image.
	 4.	 The image will rotate to position itself along the new axis.
	 5.	 Press Save.

Fig. 4.  Straightening an image

Note: It will be easier to straighten or perform other functions on 
images if the on screen image size is increased withe the Zoom tool.

Set Working Format (if format is jpg, gif, or png)
	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.
	 2.	 Change the image format, File ▶ Save As.
	 3.	 Ensure the File Name and Location are correct.
	 4.	 In the Format box, select tiff.
	 5.	 Press Save.
	 6.	 In tiff Options, select the following: Compression =  none’, 

Pixel Order = RGBRGB’, Byte Order = IBM PC.
	 7.	 Press OK.
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Fig. 5.  Converting the file format to tiff

Note: We’ll only modify our Working Image — the tiff file.
Set Working Image Resolution

	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.
	 2.	 Select Image ▶ Resize ▶ Image Size.
	 3.	 Deselect Resample Image (box should not be checked).
	 4.	 In Resolution box, enter 150.
	 5.	 Press OK.

Note: 72 or 96 DPI is standard, 150 DPI is used if a zoom func-
tion is desired.

Fig. 6.  Changing the image resolution

Cropping an Image
	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.
	 2.	 Select the Crop tool in the left tool bar.
	 3.	 Draw a rectangle around the area of the image desired.
	 4.	 Double click on the new image — or — select Image ▶ Crop in 

the main menu.
	 5.	 Press Save.

Set Working Image Size (only for reductions)
	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.
	 2.	 Select Image ▶ Resize ▶ Image Size.
	 3.	 Select Resample Image (box should be checked!)Bicubic.
	 4.	 In the Document Size box, select Inches.
	 5.	 Enter Width and Height in inches desired.
	 6.	 Press OK.

Sharpening Reduced Size Working Image (only if 
the image is better)

	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.

Fig. 7.  Cropping an image

Fig. 8.  Reducing image size

	 2.	 Select Filter ▶ Sharpen ▶ Unsharp Mask.
	 3.	  Amount = 50%, Radius = 1.0 pixels, Threshold = 0 levels.
	 4.	 Press OK.

Fig. 9.  Sharpening an image

Set Working Image Size (only for enlargements)
	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.

Continued on Page 18
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Preparing Content — Continued from Page 17

	 2.	 Select Image ▶ Resize ▶ Image Size.
	 3.	 Select Resample Image (box should be checked!) Bicubic.
	 4.	 In the Document Size box, select Percent.
	 5.	 Enter 110 in the width box.
	 6.	 The Height changes proportionally automatically.
	 7.	 Press OK.

Fig. 10.  Enlarging an image

Note: Enlarging images must be done as a series of 10 percent 
steps, not all at once. The computer adds dots throughout the im-
age based on the dots in nearby proximity. This small increment 
produces better results as the computer has to guess less at how 
many dots of what shade, etc. to add.

Balancing Color Levels (only if required)
The window with the curve indicates the white and black 

points of the image. We only need to ensure our triangles match 
the beginning and end of the curve.
	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.
	 2.	 Select Enhance ▶ Adjust Lighting ▶ Levels.
	 3.	 The curve window opens and a graphic depiction of the im-

age colors appears.
	 4.	 Ensure the Channel = RGB.
	 5.	 Move the Black Triangle to the right to the curve base.
	 6.	 Move the White Triangle to the left to the curve base.
	 7.	 Press OK.

Fig. 11.  Balancing image levels (black & white points)

Optimizing Images
	 1.	 Open the image file: File ▶ Open ▶ Choose your Image.
	 2.	 Select File ▶ Save for Web.
	 3.	 Select jpg as the format and a Quality setting.

Note: The higher the quality setting, the larger the file size.

Fig. 12.  Optimizing an image

	 4.	 Press OK’.
	 5.	 Ensure the file name and destination are correct.
	 6.	 Press Save.

Fig. 13.  Saving the optimized image

Other image modifications
Photoshop Elements provides users with many more tools to 

modify images. One option is the use of layers, which are like a stack 
of transparent sheets of paper with drawings on them. An example 
use of this function might be to reconstruct a faded or incomplete 
cancellation for illustration purposes. The original scan will be on 
the bottom sheet. If you trace over the cancellation on the top sheet, 
it will be much clearer, eliminating the texture or color of the origi-
nal envelope in the bargain. Throw away the bottom layer (or make 
it invisible) and a clear version of the cancellation is the result.

The possibilities associated with image modification are end-
less. That’s the basic reason the philatelic community is so slow to 
adopt electronic exhibiting. Fakes and manufactured items could 
be a serious issue.

Conclusion
The satisfaction of seeing the finished product essentially appear 
before your eyes as you add elements into the study is unrivaled. 
This is where the magic will take place and being well prepared by 
having all your building blocks ready is the key. Get your building 
ready as we’ll start developing a structure next.	 ✒

Thanks
My sincere thanks are extended to Alan Campbell and Richard 

Maisel for their continuing support in reviewing drafts of these 
articles and suggesting subjects for discussion.
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New Members
1951	 Elmer W. A. Cleary, 1768 De Boucherville, Saint-Bruno, PQ 

J3V 4H3, Canada. Editor: Mourning Notes (Mourning Stamps & 
Covers Club). Sponsor: John Hotchner.

1952	 Dr. Edwin J. Andrews, 13 Tullamore Drive, West Chester, 
PA 19382-7065. Author: American Revenuer and Pennsylvania 
Postal Historian. Sponsor: Alan Warren.

1953	 James R. Pullin, 2837 Wright Avenue, Winter Park, FL 
32789-6161. Author: TransAtlantic Mails: The Early Years 
1818–1840 (in progress). Sponsor: Peter Martin.

1954	 Donald James Chenevert, Jr., P. O. Box 1955, Peoria, IL 
61656-1955. Former editor: Illini Philatelist (Peoria Philatelic 
Society); Caterpillar Employees Stamp Club and Tri-Country 
Stamp Club newsletters. Sponsor: George Griffenhagen.

1955	 Dalene Thomas, 8612 W. Warren Lane, Lakewood, CO 80227- 
2352. Author: Lighthouses on Stamps handbook; Editor: Philatel-
ic Beacon (Lighthouse Stamp Society); Columnist: Topical Time 
(American Topical Association). Sponsor: George Griffenhagen.

1956	 Louis Fiset, 7554 Brooklyn Avenue, N.E., Seattle, WA 
98115-4302. Editor: The Prexie Era; Freelance Writer: Postal 
History Journal (World War II). Sponsor: George Griffenhagen.

Change of Address
0852	 F. Burton Sellers, 14515 West Granite Valley Drive, Apt. 

C225, Sun City West, AZ 85375-6037
1644	 Ted Bahry, 1026 Watervale Road, Arcadia, MI 49613

Dropped for Non-Payment of Dues
0940	 John Jerome Kriz, III
1336	 Daniel S. Pagter
1771	 Charles A. L. Swenson
1804	 George W. Holland
1831	 Kathleen Wunderly
1897	 Frederick E. Lutt
1907	 Willian T. Godfrey
1917	 George W. Forby
1919	 Peter W. F. Adgie

Secretary–Treasurer’s

Report
1922	 Ronald E. Hill
1928	 Thomas P. Johnston
1933	 James E. Kloetzel

Resignations
1756	 Joseph C. Sullivan, Towson, MD

Deceased
1527	 Barth Healey, Fort Washington, NY; obituary on page 9
1675	 Dale R. Pulver, Mentor, OH; obituary on page 10
1891	 Harvey M. Karlen, Oak Park, IL; obituary on page 9

About Writers Unit #30
The purpose of the Writers Unit #30 of the APS is to encourage 
and assist philatelic communication, knowledge, and comradeship. 
Membership is open to any philatelic writer, columnist, editor, or 
publisher — and anyone interested in philatelic communication. 

Join Us Today
Join Writers Unit #30 now and begin reaping the benefits of mem-
bership, including your subscription to The Philatelic Communi-
cator. Applications received before October 1 will be recorded as 
members for that calendar year and these members will receive all 
issues of The Philatelic Communicator for the calendar year.
Applications received on or after October 1 will be recorded as 
members for the following calendar year.

An application may be downloaded at www.wu30.org.

Membership Dues
USPS ZIP Code Addresses............................................ $15.00
 Canada and Mexico...................................................... $17.50
 All Other Addresses...................................................... $20.00
Payment must be made in U.S. funds by a check imprinted 

with a U.S. bank transit number, or by postal money order, pay-
able to APS Writers Unit #30. Some overseas members prefer to 
send U.S. bank notes by certified mail.

Updating Your Mailing Address
Please notify us of address changes to assure that you receive each 
issue of The Philatelic Communicator without delay. This will 
also save WU #30 more than $1.00 because the USPS charges 70 
cents when they have to send us an address correction, and we still 
have to pay the postage for reshipping the issue to the member.

George B. Griffenhagen, WU #30 Secretary-Treasurer
2501 Drexel St., Vienna, VA 22180-6906

Philatelic Communicator Advertising Rate Card
We can accept camera-ready copy or create an ad for you.

Deadlines January 15, April 15, July 15, October 15
Contact the editor at 813-962-7964; e-mail astarkweather@wu30.org



Writers Unit #30, APS
George B. Griffenhagen
2501 Drexel Street
Vienna, VA 22180-6906

Return Service Requested
Dated Mail — Please Rush

PRSRT STD
U.S. Postage Paid

Madrid, IA 50156
Permit No. 10

Francis Adams: Preparing Content for Digital References 
and Studies................................................................................... 1

Colopex 2008 Literature Awards`....................................................3

David L. Straight: A New Tool for Philatelic Writers 
and Researchers...........................................................................5

ATA Honoring Dennis Dengel...........................................................5

Peterson Receives Lichtenstein Memorial Award..........................6

Winter, Proud, Startup to Sign Distinguished Philatelists Roll......6

Albert W. Starkweather: Software for Digital Philatelic Studies...... 7

Obituaries 
Barth Healey, 1939–2008..............................................................8 
Harvey M. Karlen, 1918–2008.......................................................8 
James Negus, 1927–2008.............................................................8 
Dale R. Pulver, 1929–2008............................................................9.
Dmytro Bykovetz, 1935–2008.......................................................9

Advertisements

Writers Unit #30 Breakfast..............................................................9

Advertising Rate Card...................................................................19

Albert W. Starkweather: Editor’s Domain........................................2

Peter Martin: President’s Message.................................................3

Short Takes: News & Commentary.................................................4

Letters to the Editor.........................................................................4

Reviews 
	 Books & Catalogues 
		  A Tale of Three ATA Handbooks ............................................10 
		  Making the Congress Books More Useful.............................10 
		  34th USPS Guide to U.S. Stamps............................................ 11 
		  2007 Commemorative Stamp Yearbook................................ 11 
		  Collection Canada 2007......................................................... 11 
		  2008 Mellone FDC Catalogue................................................. 11 
		  U.S. Classic Postal Issues Indexed........................................12

	 Electronic Media 
	 On the Trail of Czeslaw Slania..................................................13 
	 StampExpo 400 Web Site Established.................................... 13

	 Journals & Newsletters 
	 Astrophile Back on Track.........................................................14 
	 Briefly Noted 
		  U.S.C.S. Log........................................................................... 14 
		  Seal News...............................................................................14

Secretary–Treasurer’s Report.......................................................19

	 Articles	 Departments


